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Table of Summarized Changes from Previous Version 1 
 

 
Description of Change 

 

Page or 
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The Exchange Best Practices section was updated to reflect best practices as noted in the 
Agency Pre-Cutover Readiness Guide. 
 

 
28 
 

 
Multiple sections on the Washington State Electronic Records Vault (WaSERV a.k.a. the 
Vault) were added, and can be found from page 31 to page 46. 
 

 
31 
 

Note: This table represents the substantiative changes. Typographical changes have been made throughout the 
document, but are not included in the change table.  
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Introduction and Purpose 
The purpose of the End User Training Guide is to provide end user training information to assist agencies in planning 
for a successful migration experience.  These materials are intended to assist agencies as they prepare end users to 
use the Shared Services Email offering. In order to successfully migrate users to the new offering, it is important to 
know what version of Outlook your agency is using, and what version your agency is migrating to.  For example, if 
agency end users are already using Outlook 2007 with the appropriate software levels as noted in the Agency Pre-
Cutover Readiness Guide, the end users will not have a change in their user experience for Outlook.  All users will, 
however, see a change to Outlook Web App 2010 (OWA).   
 
This guide includes information about the changes that end users will experience with OWA. This guide will offer 
information about: what agencies can expect from their new service, descriptions of features and functionalities, and 
best practices and training aids on how to use the new functions that are part of the Shared Services Email offering.  

 

The Shared Services Email offering is summarized by the following diagram: 

 

 
 

 

This Version 3 of the End User Training Guide will include training information and materials to assist agencies in 
preparing end users to successfully use their new service, including Exchange 2010, Filtering, BlackBerry®, and the 
Vault. Later versions of the guide will include the specific end user training for Secure Email.  This End User Training 
Guide does not include information for Exchange administrators.  That information will be provided in a separate 
project document.    
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This guide is organized to highlight information that is different for every user, and is specific to Outlook Web App 
(OWA).  The following sections describe a number of best practices likely familiar to end users. Following these best 
practices for email and calendaring will improve the overall experience with the Shared Services Email offering.  
Agencies are encouraged to provide this training to their end users.   

 

CTS, an agency also using the Shared Services Email offering, has an approach for the implementation of junkmail 
management that will be shared with agencies in this document.  Also provided is the end user training used by CTS. 
-- Should agencies decide to take this approach for their implementation, the end user training material available in 
this guide will be helpful.  

 
 

***** 
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Background 

On February 10, 2009, Governor Gregoire issued Governor’s Directive 09-02, directing state agencies to provide full 
assistance and support in the development and implementation of a shared services model. The Governor stated that, 
“Sharing administrative functions between agencies will allow you to focus on your core missions of providing 
essential services to Washingtonians. I expect that our new shared services approach and governance structure will 
capture the benefits of economies of scale in a way that ensures good customer service to the client agencies.” 

In response to adopting the shared services model and its governance, a Shared Services Email Project was 
identified and approved by the Shared Services Executive Steering Committee (comprised of a sub-set of agency 
directors) and the Customer Advisory Board (comprised of state agency CIOs). The overall purpose of standing up a 
new email service is to optimize the value of IT by concentrating like email services from across state agencies into a 
central service, with the goal of lowering costs and improving service. The new Shared Services Email offering was 
created through adoption of the Washington State Shared Services Model, and identified as a learning experience to 
improve the shared services model. 

This project meets the Governor’s directive by providing a shared email service.  The outcomes from this effort 
reinforce the generally accepted benefits for a shared service which include: 

• Drive cost and effort out of line and support services, including IT services 
• Add value to line and support services 
• Leverage existing agency resources, data and processes 
• Avoid duplication 
• Reduce risk 
• Reduce time for problem resolution 

 

 

***** 
 

http://www.governor.wa.gov/directives/dir_09-02.pdf
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Exchange 2010  
 
The End User Training Guide is based on the use of Exchange 2010, Outlook 2007, IronPort Filtering, BlackBerry® 
for mobile support, and Outlook Web App (OWA), and the Vault.  Later versions of the guide will include end user 
information for Secure Email. 
 
The Microsoft Exchange 2010 service provides a foundational element of the Shared Services Email offering.  Many 
of the functions that end users see will be noted in the Outlook Client Section, or in the Outlook Web App (OWA) 
section.   

 

Cached Mode 

One area where end users may see a change in their email experience is the use of Cached Exchange Mode.  Many 
agencies are already using Cached Exchange Mode in their existing Exchange environments.  For those agencies 
who are not currently implementing cached mode, the Agency Pre-Cutover Readiness Guide includes the migration 
steps to cached mode as a prerequisite to migrating mailboxes to the Shared Services Email offering and Exchange 
2010.  
 
Some users are asking why we are changing to Cached Exchange Mode. Cached Exchange Mode is designed to do 
two things: (1) increase scalability of a consolidated solution, and (2) support mobile users.  Some scenarios do not 
work with cached mode, and those scenarios will be handled accordingly.  They include virtual type solutions, specific 
implementations of shared mailboxes, and a few rare user/machine/shift scenarios. These planning tasks should all 
be coordinated with your Client Liaison for planning purposes.  For the majority of single mailbox users, cached mode 
provides a more balanced experience and better resiliency for large network implementations.  Users currently in on-
line mode may perceive a change in performance with cached mode.   

 

 

 

***** 
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Outlook Web App (OWA) 
 
Exchange 2010 and Microsoft Outlook Web App (OWA) deliver a rich, familiar web-based email experience that 
allows end users to:  

• Access email using any of the major web browsers (Internet Explorer, Safari, Firefox, and Chrome) 
• Use Conversation View to see messages in context, making it easier to manage email more efficiently and 

reduce inbox overload 
• Share calendars with colleagues both inside and outside the organization 

OWA New Addresses  

OWA allows users to access email when not at their primary workstations via a web browser.  Agencies will need to 
communicate with users that the web addresses to access OWA from both inside and outside of their agencies 
network will be new. 

• Inside their agency network,(conference room PCs, secondary computers, etc.) users can simply type 

WebMail into the address line of their web browser as shown below. 

 

 
• Outside their agency network, (another agency, the library, or from home), users can easily go  to the new 

address: https://mobile.wa.gov. Users must sign-in on this website. Note: When signing in, don’t forget to 
enter your agency\user login (e.g.CTS\jerrys)  

 

 

 

 

 

 

 

 

https://mobile.wa.gov/
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Let’s take a look at the new features and functionality available on OWA.  

Feature & 
Functionality Description User experience 

Logon Screen 
 

User logon screen for 
Outlook Web App (OWA) – 
see Image 1 

The logon screen is redesigned to more clearly present the logon options 
to users. Users may specify Private or Public when they log on. 

 

 
 

Image 1 
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Feature & 
Functionality Description User experience 

Navigation OWA navigation resembles 
Microsoft Outlook 2007 – see 
Image 2 

OWA navigation has been improved in several ways: 
• More flexible view of messages - the user can select how the list of 

messages is displayed where the reading pane appears, and also 
choose from multiple grouping and sorting options available through 
a drop-down menu. 

• Easier navigation through the list of messages by using controls at 
the bottom of the page. 

• Improved notifications - notifications and reminders appear within 
the OWA window and can be accessed by using toolbar drop-down 
menus until they are cleared. 

• Enhanced search capability - users can perform searches on mail 
and task folders. Users also have an option to refine their search 
through an extended search menu. 

• Customizable navigation pane - the user can modify the width of the 
navigation pane by dragging the vertical bar between it and the 
content list. The user can also reduce the navigation pane content 
by clicking an icon at the top of the navigation pane. This minimizes 
each section of the navigation pane to a small button along the side 
of the page. 

 

 
Image 2 



End User Guide Version 3 
 

 
Page 11 of 45 

Feature & 
Functionality Description User experience 

Drag-and-Drop Move items by dragging them 
to a new location 

OWA supports drag-and-drop operation on folders and items. 

Right-Click Right-click items to see 
actions available 

In many areas, OWA supports right-clicking to open a menu of actions 
performed most often. 

 
Image 3 

Arrange By Choose how messages are 
arranged 

The Arrange By selection is available in message folders. By clicking 
Arrange By, the user can arrange messages by date, from, and other 
options. Conversation is a new option that arranges messages in a 
threaded view by subject. 

Address Book The improved Address Book 
makes it easier for users to 
search Address Lists and 
Contacts 

The OWA Address Book includes multiple improvements: 
• Easier and more efficient searching in Address Lists and 

Contacts. 
• Clearer options when using the Address Book to select meeting 

attendees and resources. The Address Book provides options to 
limit the view to resources, or limit the search to specific address 
books. 

• When users compose email messages or meeting invitations, they 
can select any recipient field or click the Address Book icon in the 
mail form to search the Address Book for email recipients or meeting 
rooms. 
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Feature & 
Functionality Description User experience 

 

Calendar The Calendar has been 
improved to make it easier for 
users to find information and 
manage their schedules 
 

The Calendar includes the following improvements: 
• Faster access to meeting details through the optional reading 

pane in the Day and Week views. 
• Faster navigation through the calendar by using the date picker in 

the navigation pane. 
• Multiple view options enable users to view their calendar by week, 

work week, or single day views. 
• The ability to modify Calendar items by dragging them to a new 

time. 

Flagging 
Messages 

Flagged messages 
automatically appear in Tasks

When a user adds a follow-up flag to a message, it automatically appears 
in Tasks. 

Junk Email Manage junk email from 
Outlook Web App 
 
 
If you chose to manage 
junkmail with IronPort . . . 

Users can review the contents of the Junk Email folder in OWA, and move 
any messages incorrectly designated as junk to the Inbox by selecting 
them and clicking the Not Junk button on the toolbar.  
 
You can find step-by-step instructions for using IronPort on page 23 of this 
guide. 

Explicit Logon Explicit logon opens another 
mailbox in a new window 

Explicit logon enables a user to select and open any mailbox to which they 
have been granted full access. Each mailbox that is opened is displayed 
in a new web browser window. 
 
For more information about explicit logons, see How to Enable Explicit 
Logons in Outlook Web Access. 

http://technet.microsoft.com/en-us/library/aa998830(v=EXCHG.80).aspx
http://technet.microsoft.com/en-us/library/aa998830(v=EXCHG.80).aspx
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Feature & 
Functionality Description User experience 

Scheduling 
Assistant 

The Scheduling Assistant 
makes it easier to find times 
and resources for meetings 

To schedule a meeting, users can switch from the Appointment tab to the 
Scheduling Assistant tab to add attendees, search for a room, and find a 
time. Scheduling Assistant offers: 
• Improved scheduling of meeting attendees and meeting locations 

- enter names of attendees or rooms directly in the Scheduling 
Assistant or perform an advanced search using the Address Book. 

• An easier way to search for meeting times when all attendees and 
resources are available. The Suggested Times section of the 
Scheduling Assistant chooses optimal times for attendees and 
resources. Promising times are color-coded and labeled as Great, 
Good, or Poor. The availability of each attendee and resource is 
organized by Required, Optional, and Resource.  

 
 
 
 
 
 
 
 

Search The Search function in 
Outlook Web App has been 
re-designed to provide more 
accurate and faster results, 
and to reduce manual work 
and time spent finding items 
in a mailbox. 

The Search feature contains the following improvements: 
• Quick access to basic search of any folder through the search 

window at the top of each folder list. 
• One-click access lets users extend the search to other folders by 

using the drop-down list next to the search field. 
• Advanced search by using the expansion icon next to the search 

window. Advanced search lets users specify what part of messages, 
contacts, or tasks to look in. It also lets users search based on From 
or To values, and to search by category. 

Note: Search results limited to first 100 matches found.  

Type-down 
Search 

Type-down search enables 
users to find items quickly in 
message, Contacts, and 
Tasks folders. 

To use type-down search in a message folder, use Arrange By to select 
From, To, or Subject, and then start to type. For example, to search for 
any message whose subject begins with "agenda", select Subject from 
Arrange By, and then type "agenda". Type-down search also works in 
Contacts and Tasks folders, and the Address Book, searching based on 
the current Arranged By setting. 

Reminders and 
Notifications 

Exchange 2007 OWA 
includes several changes to 
the Reminders and 
Notifications features. 

The Outlook Web App Reminders and Notifications features include the 
following improvements: 
• Reminders and notifications are presented as an overlay on the 

current web browser window.  
• Users can click Reminders to view a list of current reminders. Find 

Reminders in the upper-right corner next to the Help icon. 
• Notifications that new mail has arrived are less distracting than in 
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Feature & 
Functionality Description User experience 

earlier versions of OWA. A notification appears as a brief overlay to 
the main window. A user can access the newest message by 
clicking the notification. 

• Notifications tell the user whether the new message is an email 
message, a voicemail message, or a fax. 

Regional Settings Users can select the 
language, date, and time 
settings they want OWA to 
use. 

The Regional Settings feature contains the following improvements: 
• The language setting is now independent of the browser 

language. Users can select the language they want to use in OWA 
from a list of languages under the Regional Settings section in 
Options. 

• OWA automatically sets the date style, time style, and current time 
zone based on the language setting. 

Messaging Users can select various 
Messaging options in OWA 

The Messaging feature improvements include: 
• Users can set options, such as the number of items they want 

OWA to display, and determine how notifications are displayed. All 
notifications (except Out of Office), appear as mail items that can be 
dismissed and displayed on demand. OWA shows separate 
notifications for different types of messages. These include email, 
voice mail, and fax items. 

• Users can create a personal signature and decide whether they 
want it included on all outgoing emails. 

• Users can select HTML or Plain text as the message format when 
they compose an email. Users can also change the font, color, and 
size for their messages. 

• Users can select how OWA responds to requests for read 
receipts. Users can elect to always send a response, never send a 
response, or to be prompted. 

• Users can specify how items are handled after they are displayed 
in the Reading pane. For example, they can specify that an item is 
marked as Read when the selection changes.  

Spelling OWA Premium lets users 
check the spelling of 
messages before they are 
sent 

The spell check feature in OWA offers all the options available in 
Outlook 2007, including: 
• Ignore words in UPPERCASE 
• Ignore words with numbers 
• Always check spelling before sending 

Users can also select the language for spell check. 
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Feature & 
Functionality Description User experience 

Calendar Options Users can select calendar 
and reminder options in OWA 

The Calendar Options feature lets users control multiple settings: 
• Users can turn on week numbers, select the first day of their 

week, and set time increments for the calendar display. 
• Users can select the days to show for their work week, and set the 

start times and the end times of their work days. 
• Users can set reminder notifications on their calendar and task 

items. They can also select to receive an audio notification when a 
reminder is due and the default reminder time that they prefer. 

• Users can control how meeting requests are handled. 
• New meeting requests can be tentatively added to the 

calendar. 
• Requests and responses that are out of date can be 

moved to the Deleted Items folder. 
• Meeting forward notifications can be automatically moved 

to the Deleted Items folder. 

Out of Office 
Assistant 

Users can auto-reply to 
senders when they are out of 
the office, or send messages 
to senders for a specific 
period of time. 

Out of Office Assistant improvements include: 
• Scheduling Out of Office messages in advance. 
• Customizing separate Out of Office messages for their internal 

and external email senders. 
• When users send Out of Office messages to external senders, 

they can select to send the messages to external senders who are 
included in their Contacts list, or to anyone outside their 
organization. 
 
 

Search Folders Search Folders are virtual 
folders that provide a view of 
email items that match a set 
of criteria. For example, the 
default Search Folder Unread 
contains a view of all unread 
messages. 

The Search Folders icon is always visible in OWA, even if you have 
disabled the feature. Custom Search folders created in 
Microsoft Office Outlook will not be visible unless they have been 
initialized on the server that is hosting the user's mailbox. Search folders 
that are created in Outlook when users are working in Online mode are 
automatically initialized on the server. Custom Search folders that are 
created when users are using Outlook in Cached Exchange or Offline 
mode are not automatically initialized on the server and will not be visible 
in OWA. To initialize these folders on the server, switch Outlook to Online 
mode and open each of the Search Folders. You can then switch back to 
Cached Exchange mode. 
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Feature & 
Functionality Description User experience 

General Settings A set of miscellaneous 
settings that control the user 
experience. 

Users can set the following options in General Settings: 
• Email Name Resolution - in the Premium version of OWA, users 

can select whether to check first in the Global Address List or 
Contacts. This option is set in Messaging in OWA Light. 

• Appearance - users can select the color scheme that they want to 
use for their OWA session. 
 

Resource 
Mailbox 

Resource mailboxes can be 
configured and managed by 
using OWA 

When a resource mailbox is opened using OWA, Resource Settings is 
added to the Options menu. The owner of a resource mailbox can set the 
following properties: 
• Resource scheduling options 
• Resource scheduling permissions 
• Resource privacy options 
• Response messages 

User receives a 
warning message 
when they click 
an embedded link 

Users may be prevented from 
opening potentially unsafe 
links. 

If a user clicks an embedded link that uses a protocol that is not 
recognized by OWA, the link will be blocked and the user will see the 
warning "Outlook Web Access has disabled this link for your protection". 
This protects users from potentially harmful content. 

The user 
receives a 
warning that a 
request will not 
be processed 

Some user requests will be 
blocked by OWA. This feature 
is available only in OWA 
Light. 

Every form request that is sent to the Client Access server that is hosting 
Outlook Web Access, such as a request for a new email message, 
includes a unique identifier. If Outlook Web Access receives a request that 
does not include the correct identifier, it will reject the request. This 
prevents unauthorized processes from using Outlook Web Access as a 
transport mechanism. 
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Outlook 2007/2010 Resources 
 
The following information is provided for Outlook calendars.  This information is not specific to the actual cutover of 
mailboxes during migration, but as a refresher for agency internal users.  It is only provided to assist users in best 
practices in their Outlook experience following these best practices for calendaring and scheduling will improve their 
overall experience with the Shared Services Email offering.  Agencies are encouraged to provide this training to their 
end users. 
 
The resources offered in this section are to assist end users while they migrate over to the Shared Services Email 
offering.  
 
Agencies using Outlook 2003 and moving to Outlook 2007 as they migrate to the new service will see some 
differences in the new version. To aid the end users, included are some links to online training on how to use the new 
version. 
 
End users will learn what has changed, how to find everyday commands, and a quick reference card to use at their 
desk.  
 
Up to Speed with Outlook 2007 
 
Agencies using Outlook 2003 or 2007 moving to Outlook 2010 as they migrate to the new service will also see 
differences in the new version. To aid those end users, included are more links to online training on how to use the 
new version. End users will learn what has changed, how to find everyday commands, as well as a quick reference 
card to use at their desk.  
 
Make the Switch to Outlook 2010 
 
Outlook Best Practices  
Now that you are ready to use your new service, there are recommendations on best practices to get the most 
functionality from the service. 

No matter if you are using Outlook 2003, 2007, or 2010, these best practices will ensure a successful experience. 

 

1. Outlook Meeting Request: Essential dos and don’ts  

• Make a choice   Accept, accept as tentative, or decline each meeting request that you receive, especially if it 
is an update to a meeting request that you previously accepted. By making a choice, you keep the meeting 
organizer apprised of your decision and you prevent the meetings that you want to attend from being 
accidentally deleted. If you need to attend a meeting but can't at the time it is scheduled, you can propose a 
new time for the meeting.  Try not to delete a meeting request outright, because this is one way that meetings 
get "lost." 
 

• Don't forward meeting requests as a method to add a user to a meeting. Add them to the “To:” line of a 
meeting and update. 
 

• Rules of any kind should not be applied to meeting reponses of any kind. 
 

• Send updates  After modifying one of your own meeting requests, remember to click Send Update to send 
the updated request to all recipients.  

 
• Cancel a single meeting   If you need to cancel a meeting, it is considerate to notify the people you invited. 

Delete the meeting from your calendar, click Send cancellation and delete meeting, and then send the 
cancellation to everyone you invited.  
 

http://office.microsoft.com/en-us/training/up-to-speed-with-outlook-2007-RZ010115400.aspx
http://office.microsoft.com/en-us/outlook-help/make-the-switch-to-outlook-2010-RZ101809884.aspx?CTT=5&origin=HA010370219
http://office.microsoft.com/en-us/outlook-help/outlook-meeting-requests-essential-dos-and-donts-HA001127678.aspx
http://office.microsoft.com/search/redir.aspx?AssetID=HP030880561033&CTT=5&Origin=HA011276781033
http://office.microsoft.com/search/redir.aspx?AssetID=HP030880561033&CTT=5&Origin=HA011276781033
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• Never use “No End Date” for scheduling a recurring meeting during the lifespan of a meeting created 
with “No End Date”, there may be exceptions made to single occurrences of the meeting. When each 
exception (change in location, date, time, etc.) is made, an attachment is created and attached to the original 
meeting. The more changes made, the greater the chance a loss in meeting reliability will occur. This may 
present itself as duplicate meetings, single exceptions reverting to the original information, lost attendees, 
missing meetings on calendars, and more.  

 
• Cancel recurring meeting   If you, as the meeting organizer, are ending a recurring series of meetings, open 

the meeting on your calendar, set a new end date, and then send an update. This keeps the past meetings on 
everyone’s calendars, but future occurrences after the end date are removed.  

 
• Change meeting organizers   If a recurring meeting is changing to a new organizer, there is not a way to 

reassign the ownership of the meeting. The original organizer should send an update with a new end date — 
the past meetings remain on everyone’s calendars, but future occurrences after the end date are removed. 
The new meeting organizer should send a new meeting request for meetings in the future.  

 
• Keep meetings from vanishing   If you run Outlook on two computers and accept a meeting while using one 

of them, don't delete the meeting request from the Inbox on the other computer. If the request is still there, 
accept it again. Deleting a request on one computer after accepting it on another computer can cause the 
meeting to disappear from your calendar.  

 
• Process meeting requests and updates from the Inbox   Always accept or decline a meeting request from 

your Inbox. Yes, Outlook allows you to accept or decline a meeting from its time slot on your calendar, but 
that can leave the meeting request in your Inbox. Leaving the meeting request in your Inbox might confuse 
you later and definitely leaves any delegates  you appointed wondering whether the meeting was accepted. 
(Delegate: Someone granted permission to open another person's folders, create items, and respond to 
requests for that person. The person granting delegate permission determines the folders the delegate can 
access, and the changes the delegate can make.) 

 
• Keep your meeting notes separate   As a meeting attendee, avoid adding your own private notes to the 

body of a meeting request in your calendar. If the organizer updates the meeting, your notes are lost.  
 

• Don't move meeting requests   Don't move a meeting request from your Inbox to a different folder before 
you accept or decline the request or before the meeting appears in your calendar. Soon after a meeting 
request arrives in your Inbox, a piece of Outlook code — nicknamed the "sniffer" — automatically adds the 
meeting to your calendar and marks it as tentative. This is a fail-safe way to keep you from missing the 
meeting in case you don't see the request in your Inbox. However, the sniffer doesn't reply to the meeting 
organizer. You still need to do that by accepting, accepting as tentative, or declining the request.  If you, or a 
rule that you create, move an incoming meeting request from your Inbox before the sniffer can process the 
request, the meeting never appears in your calendar, and you might miss the meeting. 

 
• May Adrienne come, too?   If you receive an invitation for a meeting and believe someone else should also 

attend it, instead of forwarding the meeting request to that person, ask the meeting organizer to add that 
person to the attendee list, and then to send everyone an updated meeting request. This avoids surprising the 
organizer with an unexpected attendee and helps prevent lost meeting requests.  

 
• There is always room for one more   If you are the meeting organizer and you want to invite another person 

after sending the original meeting request, add the person to the attendee list (the To line) of the original 
meeting series or occurrence, and then send an update to all attendees.  

 
• Convert an appointment to a meeting request   If you want to create a meeting from an appointment on 

your calendar, open the appointment, click Invite Attendees, and then select the people you want to invite. 
This converts the appointment to a meeting request.  

 

javascript:AppendPopup(this,'IDH_redefDelegate_1')
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• Remove it right   If you receive a meeting cancellation, click Remove from Calendar to remove the meeting 
from your calendar. Deleting the cancellation from your Inbox won't remove the meeting from your calendar.  

 
• Try not to change an existing attendee list  Suppose the attendee list in one of your meeting requests 

contains two instances of a person's name. If you delete one of the names, and then send a meeting update 
to the "Removed or Added Attendees," the person receives a cancellation. Similarly, if you send the meeting 
update to "All Attendees," the person receives both a cancellation and an update.  

 
• Be careful with DLs   Try to avoid sending meeting requests to distribution lists (DLs), particularly lists on 

which you are a member. If you need to invite all the members of a distribution list, expand the list in the To 
line before sending the request. If you need to add or remove attendees from a meeting request that you 
already sent to an unexpanded distribution list, don't expand the list and start adding or deleting names. 
Instead, cancel the meeting and create a new one.  

 
• Don't auto-accept requests   If you have granted one or more persons delegate access to your calendar, or 

if you have delegate access to someone else's calendar, turn off automatic acceptance of meeting requests. 
By turning off automatic acceptance, you avoid problems with delegate workflow.  

 
• Avoid calendar clutter   To make people aware of your schedule, or to let them know when you plan to be 

away from the office, don't send a meeting request or forward appointments that block out portions of your 
schedule on their calendars. Instead, share your calendar with them. If you don't want to share your calendar, 
you can still use a meeting request to let people know when you will be away from the office. Before you send 
the meeting request, set Show time as to Free so that it doesn't block out the time that you are away as Busy 
or Out of Office on the other people's calendars.  What if someone sends a meeting request or appointment 
that blocks out portions of your calendar? If you accept the item set Show time as in the item to Free. (Item: 
An item is the basic element that holds information in Outlook - similar to a file in other programs. Items 
include email messages, appointments, contacts, tasks, journal entries, notes, posted items, and documents.) 

 
• If you don't want to receive meeting request responses...   Typically, it is best to know in advance who 

plans to attend a meeting that you schedule. By default, Outlook meeting requests ask for a response from 
each person you invite. You have the option not to receive responses to your meeting request, but then you 
won't know who accepts, accepts as tentative, or declines it. However, if you schedule a large meeting or an 
event and you don't want to receive a response from each person you invite, turn off the Request 
Responses option before you send the meeting. 
 
 

 
The following information is provided for Outlook permissions and delegates as well as folder permissions.   This 
information is not specific to the actual cutover of mailboxes during migration, but as a refresher for agency internal 
users.  It is only provided to assist users in best practices in their Outlook experience.  Following these best practices 
for permissions and delegates, as well as folder permissions, will improve their overall experience with the Shared 
Services Email offering. Agencies are encouraged to provide this training to their end users. 
 
 
 
 
Outlook Permissions for Delegates and Folders 
 
Authorizing folder access, such as allowing someone to view your calendar, or granting someone delegate authority in 
Outlook, are two very different permission levels.  Understanding the differences will assist you and minimize the 
number of calendaring issues you may encounter.  The following information is provided to show how CTS is training 
CTS users on these best practices.  
 
 
 

http://office.microsoft.com/search/redir.aspx?AssetID=HP052578031033&CTT=5&Origin=HA011276781033
http://office.microsoft.com/search/redir.aspx?AssetID=HP052432221033&CTT=5&Origin=HA011276781033
http://office.microsoft.com/search/redir.aspx?AssetID=HP011111491033&CTT=5&Origin=HA011276781033
javascript:AppendPopup(this,'IDH_redefItem_2')
javascript:AppendPopup(this,'IDH_redefItem_2')
javascript:AppendPopup(this,'IDH_redefItem_2')
http://office.microsoft.com/search/redir.aspx?AssetID=HP010771691033&CTT=5&Origin=HA011276781033
http://office.microsoft.com/search/redir.aspx?AssetID=HP010771691033&CTT=5&Origin=HA011276781033
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Setting Folder Permissions: 
 
When setting folder permissions, such as giving REVIEWER rights on our calendars to CTS staff, we are doing just 
that, and nothing more.  When someone opens and views our calendar, they can see appointments, but cannot 
create, delete, or move any of our meetings.  Here’s an example of how to grant REVIEWER Permissions to All CTS 
Staff: 
 
In your Calendar, right click and then choose Properties 

 
 
 
You should now see the following window. You can see here that reviewer rights have been given to our all CTS 
distribution list. 
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Granting Delegate Access: 
As the person adding a delegate, you determine the level of access that the delegate has to your folders. You can 
grant a delegate permission to read items in your folders or to read, create, change, and delete items. By default, 
when you add a delegate, the delegate has full access to your Calendar and Tasks folders. The delegate can also 
respond to meeting requests on your behalf. 
 
If you grant someone access to your Exchange folders, that person has access to all items in the folders except those 
marked private.   IMPORTANT   If you grant someone access to your private items, this is a global setting that affects 
all of your Exchange folders, including all Mail, Contacts, Calendar, Tasks, Notes, and Journal folders. You cannot 
allow access to private items in only one folder. 
 
Basic Guidelines: (Note: altering from these guidelines has the potential to cause issues). 

1. There should be only one delegate for each manager, if possible. 
2. If the delegate receives meeting notices for the manager, only one of the two should accept meeting notices 

as a rule. 
3. If the manager has a Blackberry, they should not compose or respond to meeting notices from the Blackberry. 
4. Re-occurring meetings should be limited to six month blocks if possible. 

Setting Delegate Permissions: 

In Outlook, go to Tools/Options and then click the Delegates tab. 
 

http://helpdesk.hputx.edu/Outlook/Microsoft%20Outlook%20Delegates.pdf
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Click the Add button, and you will be able to browse for the person you are seeking. 
 
 
Once located, highlight the name and then click Add at the bottom of the window. 
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You now have the ability to designate each folder. 
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Managing Your Junkmail 

Junkmail is advertising that arrives in your postal mailbox along with the mail you really want or need. It's impossible 
to eliminate all of it, but you can substantially reduce the amount of junk mail you receive. There are a number of 
options for agencies to use when managing junk email.  One option is to use the built in feature in Outlook, and 
another is using IronPort Services offered by CTS.  CTS has made the choice to turn off all Outlook junk mail features 
and solely use IronPort for our internal users.  This decision was based on the ease of maintenance and benefits to 
end user support. 

The material below is provided as end user training if your agency chooses to follow the approach that CTS has 
taken.  
The following is a step by step guide that shows you how to manage your Junkmail.  
 
 
Logging In to End User Quarantine or Junkmail 
 
Logon to http://junkmail.wa.lcl 
 
 

 
 
 
Logon using your email address and current active directory (AD) password 
Username:  joele@CTS.wa.gov 
Password: [Current AD Password] 
 

 

Click  
 

http://junkmail.wa.lcl/
mailto:joele@dis.wa.gov
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Safelist 
 
Once logged on, there are 2 ways you can ensure an email to bypass the End User Quarantine or EUQ using 
“safelisting”. 
 
1) Check the box next to the email you wish to be safelisted. Use the drop down under the Select Action and Select 

– Release and Add to Safelist 
 

 
 

Click  
 
The email will then be added to your safelist, and sent off for delivery. 
 
 
2) Mouse over the Options in the upper right hand corner and Click on Safelist 
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Type the email address you wish to safelist into the available field and click  
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Blocklist 
Mouse over the Options in the upper right hand corner and Click on blocklist 
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Type the email address you wish to blocklist into the available field and click  
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Exchange Best Practices 
 
Implement best practices. The following are some best practices that will make email accounts perform better: 

• Do not store messages in the deleted items folder.  Keep the deleted items folder cleaned out.  Set it 
to auto-delete upon exit. 

• Delete old calendar items. 
• Only attach the calendars that are needed. 
• Delete Outlook Rules and Alerts that are not used, and check these rules periodically in the future. 
• Check Outlook Add-ins and make sure they are really used since they can cause major Outlook 

delays. (see “How to troubleshoot performance issues in Outlook 2007”, 
http://support.microsoft.com/?kbid=940226 ) 

• Keep the number of email messages in “critical path” folders as low as possible by creating multiple 
folders to sort and organize emails. Critical path folders include the following: 
 

 Inbox 
 Sent Items 
 Deleted Items 
 Contacts 
 Calendar 
 Tasks 

  
Note: While Exchange 2010 can potentially handle up to a critical level of 100,000, it is usually slow depending on 
many factors like the client’s hardware.  While each environment is different and loads vary, overall it is good to keep 
the item counts below 10,000  in any critical path folder to provide the highest Outlook client satisfaction. (See 
Understanding the Performance Impact of High Item Counts and Restricted View, http://technet.microsoft.com/en-
us/library/cc535025(EXCHG.80).aspx, as well as do the following:  

 
• Check contacts folder to make sure all of the addresses are current. 
• Manage sent items.  Delete old items. 

 
Note: There is no best practice when it comes to folder performance, whether or not folders are inside  or outside of 
the inbox. The general “rule of thumb” is to have folders outside of the inbox to prevent issues unrelated to 
performance. For example, an inbox retention policy meant to clear out items older than 90 days will negatively affect 
user with a folder labeled “Special Folder – Keep 10 years” under the inbox. In this a scenario, such a folder  will be 
processed according to the 90-day deletion policy.(“Understanding Database and Log Performance Factors”, 
http://technet.microsoft.com/en-us/library/ee832791.aspx 
 

http://support.microsoft.com/?kbid=940226
http://technet.microsoft.com/en-us/library/cc535025(EXCHG.80).aspx
http://technet.microsoft.com/en-us/library/cc535025(EXCHG.80).aspx
http://technet.microsoft.com/en-us/library/ee832791.aspx
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BlackBerry® Mobile Messaging 
Note: If you are not planning on supporting end users who need mobile device support (BlackBerry®) you can skip 
this section.  

Agencies can keep staff connected to the office with Blackberry® Service. The BlackBerry® Service synchronizes 
your BlackBerry® device to an Exchange 2003 or 2010 mailbox that is connected to the Enterprise Active Directory 
(EAD). This supplies access to your Microsoft Outlook email, calendars, and address books; and, provides access to 
the state’s Global Address List. 
 
The existing BlackBerry® Service available today from CTS will be the supported BlackBerry® service to interface 
with the Shared Services Email offering.  If an agency has a requirement for BlackBerry® with email, migration to the 
existing service offering is a prerequisite to using the Shared Services Email offering.   

End user training for BlackBerry®  can be found at the following web links:  

• How BlackBerry® enterprise activation works – step by step process - 
http://www.blackberry.com/support/enterpriseActivationPackage/enterpriseActivation/activationProcess.html 

 
• Device user guides and getting started guides for all models of Blackberry’s ®  - 

http://na.blackberry.cofm/eng/support/devices/. 
 

• BlackBerry® 101 - http://na.blackberry.com/eng/support/blackberry101 
 

CTS has found that following Microsoft’s Essential Dos and Don’ts, previously discussed in this document, contributes 
to a successful BlackBerry® experience. 

 

 

 

 

 

 

 

 

 

 

 

 

 

http://www.blackberry.com/support/enterpriseActivationPackage/enterpriseActivation/activationProcess.html
http://na.blackberry.com/eng/support/devices/
http://na.blackberry.com/eng/support/blackberry101
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Washington State Electronic Records Vault (WaSERV a.k.a. the Vault)  

 
Washington State employees use email to process large amounts of 
information. Our email must be handled in a manner that complies with 
legal, audit, program and fiscal requirements.  
 
To achieve this, we are using Symantec Enterprise Vault, which we call 
WaSERV or the Vault. The Vault stores email based on an agency’s 
records retention requirements.  
 
We've posted the information below to familiarize you with the Vault, 
provide tips on using it and introduce you to the Vault icons and tools you'll 
use in Outlook. Remember: you are responsible to manage your email in 
compliance with your agency policy and Washington State law. 

 
About the Vault 
 
The Vault creates space in your mailbox by automatically moving items in your mailbox to a storage area on the 
network. The storage area is called the Vault. Every item stored in the Vault is safely replicated. Each item can be 
easily viewed, or found using the search feature. A shortcut will exist in your mailbox to each stored item. You can 
double-click the shortcut to access the stored item. 
 

Why do I need the Vault? 

Secretary of State policy requires you to keep all email messages that may be a matter of public record or interest. All 
mailboxes will use the Vault to store email. 
 
What are the benefits of the Vault? 
The Vault offers benefits beyond regulatory compliance and public disclosure, including:  

• The ability to effectively manage email without changing the way you work.  
• The ability to store your email in a single location that you can easily search.  
• Improved business continuity.  
• A searchable repository of corporate knowledge.  

 
 
Does the Vault affect how I use email? 
 
No. The Vault won't disrupt your ability to use Outlook. The way you send and receive email won’t change. The Vault 
automatically moves email to the Vault for you. Once email is in the Vault, you’ll be able to read it, but not delete it.  
 
How to use Vault Shortcuts 
When the Vault stores an email, it will leave a shortcut to it in your mailbox . The shortcut is a direct link to the 
stored email.  

Double click the icon to view the contents of the original email. Apart from this icon, a stored item looks just like 
any other item in your mailbox. The email's subject line, date, and sender's information are all displayed.  
 
If you do not have a shortcut to a stored item, you can still search for items in the Vault by using the Search Vaults 

tool:  or by viewing lists of vaulted items by using the Archive Explorer tool  

javascript:Show_Stuff(display20)
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Mailbox Icons and Buttons 

Enterprise Vault Mailbox Icons for Outlook 2003/2007/2010 
 
Items in your mailbox may be marked with the following icons.  
 
Button Icon Description 
Shortcut to archived item 

 

Double-click the Vault shortcut to view the contents of the 
original item. The Vault shortcuts will stay in your inbox for the 
number of years based on your agency’s policy.  Default is one 
year. You may delete shortcuts from your inbox and the email 
will still be in the Vault. You can find Vaulted email without 
shortcuts by using the Search Vault or Archive Explorer buttons 
on your toolbar. 
 

Pending archive 

 

This button shows that an item is being archived in the Vault. 
Double-click the item to view it. 
 

Pending restore 

 

This button shows that you have chosen to restore the item from 
your Vault. The restored item is the same as it was before it was 
vaulted, and has its original icon. A copy of the item remains in 
the Vault. 
 

Pending deletion 

 

This button shows that you have chosen to delete the item from 
your Vault. Enterprise Vault also deletes the shortcut from your 
mailbox (Not available with WaSERV) 

 
 
Depending on how your administrator has set up Enterprise Vault, a number of buttons may be available on the 
Enterprise Vault tab or on the Microsoft Outlook ribbon. 
 
 
Enterprise Vault Tab for Outlook 2010 

 
 
 
Enterprise Vault Client Icons (Buttons) on the Outlook 2003/2007 Toolbar  

        
 
 

 
 



End User Guide Version 3 
 

 
Page 33 of 45 

 
 
 
Enterprise Vault Toolbar Buttons: 
 
You may find more information on toolbar buttons for the Enterprise Vault by going to the Help drop down in Outlook 
and selecting Enterprise Vault Help Topics from the drop down list. 
 
The following buttons may be available on the toolbar or ribbon depending upon your agency’s configuration of the 
Enterprise Vault.  
 
 
Button 2003/2007 

Icon 
2010 
Icon 

Description 

Search Vaults 

  

This button allows users to search for items 
stored in the Vault via a web browser. 
 

Archive Explorer 

  

This button displays a tree view of the items 
stored in the Vault. 
 

Store (Store in Vault) 

  

This button stores the selected items 
without waiting for Vault to store them 
automatically. 
 

Restore from Vault 
 

  

This button restores the items associated 
with the selected Enterprise Vault shortcuts. 
This command can only be used on items in 
the mailbox, and not on items in the Vault. 
 

Delete (Delete from 
Vault) 

  

If available, this button deletes archived 
items, and can only be used on items in the 
mailbox – not on items in Vault. 
 

Cancel (Cancel 
Operation) 

  

This button cancels the Enterprise Vault 
operation that is currently in progress. This 
option can only be used on items in the 
mailbox, and not on items in the Vault. The 
following operations can be cancelled: 
 

• Delete (Delete from Vault) 
• Store (Store in Vault) 
• Restore (Restore from Vault) 

 
Update Offline Vault 

 

Icon not 
available  
for 2010. 

This button downloads items to the offline 
Vault. 
 

Prioritize Items to 
Download 

 

Icon not 
available 
for 2010. 

If available, this can control the order in 
which Enterprise Vault downloads items to 
the offline Vault. 
 

Expiry Report 

  

This button lists the items Enterprise Vault 
will delete from a user’s Vault as their 
retention period draws to an end. If 
necessary, these items can be restored to a 
user’s mailbox. 
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Button 2003/2007 
Icon 

2010 
Icon 

Description 

Configure Vault Cache Icon not 
available for 
2003/2007. 
 

 

This button opens the Vault Cache 
Properties dialog box. 
 

Enable Vault Cache Icon not 
available for 
2003/2007. 
 

 

This button runs the Vault Cache wizard. 

More Actions Icon not 
available for 
2003/2007. 

 

This button displays additional Enterprise 
Vault commands. The Enterprise Vault 
administrator controls which options appear 
on the Enterprise Vault tab, or on the More 
Actions menu. 
 

Synchronize 
(Synchronize 
Vault Cache) 

Icon not 
available for 
2003/2007. 
 

 

This button synchronizes Vault Cache with 
your online Vault. 
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Using the Vault 

Your Vault search lets you search for stored items by opening a web browser. 
 
To search for an item in the Vault: 

Click Search Vaults on the toolbar. You can also select the Tools menu, click Enterprise Vault > Search 
Vaults. 
 
Complete the fields in the form to search for items.  
 
 
You can store a complete folder in the Vault, and you can also include all its sub-folders. However, you cannot store a 
complete mailbox.  
 
To store a complete folder in the Vault:  
 
In your Folder List view, click the folder you want to store in the Vault. If your mail folders are not listed then click 
Folder List or Folders on the View menu.  

Click Store in Vault on the toolbar. You can also select the Tools menu, click Enterprise Vault > Store in 
Vault.  
 
If you want to store all sub-folders of the selected folder, click Include sub-folders. Click OK. You can continue 
working while the Vault stores the folder.  
 
 
To store an item in the Vault:  
Select the items that you want to store.  

Click Store in Vault on the toolbar. You can also select the Tools menu, click Enterprise Vault > Store in 
Vault. 
 
Click OK to store the items.  
 
 
Mailbox Management 
 
When does my email move into the Vault? 
 
Every evening, the Vault stores email that is older than the specified number of days based on your agency’s 
retention policy; the default is 30 days. Once you send or receive an email, you have the specified number of days to 
either delete it or keep it for the Vault to store.  
 

How long will my email stay in the Vault? 

The Vault stores email based upon your agency’s records retention requirements. For more information about records 
retention and your individual retention period, please contact your agency records officer.  
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What if I need to keep email longer or shorter than my assigned retention period? 

You may have the ability to store email in a folder with a longer or shorter retention policy. The email in the custom  
folder will be stored in the Vault with the number of years specified on the custom folder. Please contact your 
agency’s records officer for recommendations email retention.  
 
What if an email needs to be sent to the Secretary of State Archives? 
 
Only between two and five percent of public records are considered archival. Email designated as “archival” pursuant 
to your agency’s records retention schedules should be processed per your agency’s records retention policy. 
 

Can I delete email? 

 Yes, just as paper records can be recycled or destroyed, emails may be deleted pursuant to your agency’s records 
retention schedules. Email that is not deleted with the specified number of days will automatically be moved to the 
Vault for the retention period assigned to your mailbox. Once email is in the Vault, you will be able to read it, but you 
will not be able to delete it. For more information about deleting email, please refer to your agency’s records retention 
policy.  
 

What happens to email in my Deleted Folder? 

Messages you receive or create move into the Vault once the message is older than the period assigned by your 
agency; typically 31 days old. Be sure your email records management methods comply with the your agency’s 
records retention policy. Delete any transitory message and unnecessary email. Storing large amount of email items 
in non-vaulted folders will increase the overall size of your mailbox and may be against your agency’s records 
retention policy. Need help deciding which emails should be kept for business purposes and which should be deleted? 
Contact your agency records officer. 
 

How can I be sure it’s okay to delete email? 

Email can be deleted and received using state resources are state property and are subject to disclosure and 
discovery requirements. You should carefully review the policies that relate to email and understand your 
responsibilities to delete or keep them.  
 

What happens to email in my Drafts Folder? 

Email without a proper send date cannot be vaulted because the system does not know when the start date is; so the 
Drafts Folder is excluded from the Vault. This includes emails that were typed but not sent.  If you store an email in 
the Drafts Folder that has a date it will be vaulted. 

How can I learn more about records retention and email usage?  And,Who do I contact with questions about 
email retention? 

If you have a question about email retention and have already consulted your agency’s records retention policy, 
contact your agency’s records officer.  
 
Who do I contact with questions about using the Vault tool? 
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If you have a question about how to use the Vault, contact your agency’s help desk. 
 
Enterprise Vault with Outlook Web App 
 
The new view of Outlook Web App (OWA) for Enterprise Vault display of Archive Explorer and Search Archives 
now show up in your folder list on the left (circled in red).  You will also notice some changes to the icons in OWA 
(circled in purple).  And, no longer are the vault icons displayed on the OWA Toolbar (circled in green). 
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The new view of Outlook Web App (OWA) for Enterprise Vault Archive Explorer and Search Archives now show 
up in your folder list on the left. 
 

      
 
 
Click on Archive Explorer and the Security Alert box opens.  Click Yes. 
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Archive Explorer opens in a new window. 
 

 
 
 
 
You can expand the mailbox archive you wish to view and click on the folder to display the items. 
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You can use the Search button to find items: 
 

 
 
 
Click the Red X to close Archive Explorer. 
Click on Search Archives and click No to start the window. 
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The Search page will be displayed. 
 

 
 
 
Enter your search criteria and press enter. 



End User Guide Version 3 
 

 
Page 42 of 45 

 
 

 
 
 
To get back to your email, click on the Mail folder in the left hand column. 
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To manually store an item in the Vault, right click on the item, and select Archive from the drop down list.  
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A conversation window is displayed asking if you want to archive the item.  Select OK to Vault or Cancel to cancel the 
operation. 
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